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Introduction to Freefall

Freefall is a satellite simulator with spectacular graphics that uses high-
precision, industrial-grade orbit propagation models to accurately
predict the motion of real satellites. In addition to their positions,
Freefall can calculate and display the satellites' line-of-sight footprints,
user-defined radio ground-links and satellite network, and the area
coverage of a hypothetical sensor system.

A variety of Earth features can be displayed including: imagery,
political boundaries, coastlines, a reference grid, and night shading. The
friendly interface allows users to control the simulation, change the
view perspective, modify satellite display properties, edit the views in
the transition list, choose which cities from a database of over 28,000 to
display, and discover information about more than 850 included
satellites.
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Freefall's key design feature is the fusion of engineering precision and
aesthetics; a fine balance between intense engineering and graphics
computations. The rendered scenes are simultaneously mesmerizing and
accurate. The raw power of the Mac OS X / PowerPC architecture and
the high-performance Freefall calculation libraries immerse the viewer
with a state of realism unlike any other satellite simulator.
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Installation and Quick Start

Installation

To install the Freefall application on Mac OS X, double click the file
"Freefall.pkg" and follow the on-screen instructions. The installer will
install the required files for both the stand-alone Freefall application and
the Freefall Screen Saver.

Starting Freefall

Freefall behaves like other Mac OS X applications; to start it simply
double-click on its icon from the Finder, or single-click on its icon in the
dock. The Freefall application is installed in the Applications folder.

Initial Launch

A splash screen will appear. If you purchased the software from a retail
store and have a serial number, please enter it before continuing. If you
downloaded a trial version, select "Try" to run Freefall in its limited
mode, "Information" to learn what these limitations are and how to
purchase an unrestricted version of Freefall, or "Buy Now" to buy an
unrestricted version.

The first time you start Freefall, sit back enjoy the ride for a minute or
so. The simulation starts immediately and the scenes will transition
automatically about every few seconds. It's fun to watch.

Simulation

To control the simulation use the "Speed," "Time," and "Increment”
controls in the Toolbar or the items in the "Simulation" menu. To
change the current simulation, use the "Simulation" control in the
Toolbar or the items in the "File" menu.

Mouse Controls to Rotate, Zoom, Pan, and Select Satellites
Use the mouse to rotate, zoom, or pan the view in the main window.

To rotate the current view, click and drag the mouse in the main display
window. Use the left mouse button on mice with multiple buttons.
Generally, move the mouse in the same direction you wish to rotate the
scene. If this does not seem intuitive to you, practice first with simple
motions (left only, right only, down only, up only). If you hold the
option key down when clicking the mouse, the rotation will be restricted
to a single axis.

To zoom in or out, press the shift key while clicking and dragging the
mouse. Or, if the mouse has a middle button, simply click the middle
mouse button and drag. Moving the mouse up zooms out. Moving the
mouse down zooms in. Alternatively, if the mouse has a scroll wheel,
moving the scroll wheel down should zoom in and moving it up should
zoom out.

To pan the scene, press the control (ctrl) key while clicking and



dragging the mouse or by clicking the right mouse button and dragging.
The view will move with the mouse.

The center of the scene, the focal point, is either the center of the Earth,
a location on the surface of the Earth (generally a city selected in the
Cities window), or a specified satellite; keep this in mind as you rotate
and zoom. The behavior may appear to change but it is the same, just
the focal point of the view has changed. To select the current
perspective, use the "Perspective" controls in the Toolbar.

If the mouse is over a satellite (even one obscured by the Earth), when
the mouse is clicked, then the satellite will be selected instead of
entering rotate or zoom mode.

To select a satellite, click on it. Click on it again to deselect it. Double-
clicking on a satellite will select all the satellites in its group, and triple-
clicking will select all the satellites. To select multiple satellites, hold
down the shift key while clicking the mouse.

Appearance, Views, Satellites, Cities, and Info

To change the simulation's general appearance, including the Earth
display characteristics, open the Appearance window by using the
"Appearance" button in the Toolbar.

The simulation Views, Satellites, and Cities windows can be opened in
the drawer by clicking on their corresponding buttons in the Toolbar or
at the top of the drawer. The Info window displays information about
the currently selected satellite, but only if a single satellite is selected.

Freefall Screen Saver

The Screen Saver functions just like any other Mac OS X Screen Saver.
Simply Open the System Preference and click the "Desktop & Screen
Saver" preference. Select the "Freefall" Screen Saver from the list on
the left. Click "Options" to configure the Screen Saver's basic settings.
You will be required to enter the serial number again for full Screen
Saver functionality.
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Becoming familiar with the interface

Besides a standard main menu in the system menu bar, Freefall has
three basic components that are shown in the figure below:

e

Main Window

The main window displays the Earth and satellites. With the mouse,
users can interact with this window to change its perspective and select

satellites. Freefall's high-speed rendering engine allows it to respond
quickly to the user.

The following image indicates a number of the common features visible
in the main window:

" ]

Drawer
To the right or left of the main window, but nominally on the right, is a
Drawer that can be opened or closed by the user. The Drawer contains



five windows, but only a single window at a time is visible.

The Drawer windows are:

General display settings, including

Appearance
pp Earth
. List of simulation views and transition
Views .
settings

List of satellites and their display

Satellites .
settings

Cities List of cities

Info Information about the selected satellite

Toolbar

Above the main window is a customizable Toolbar that gives users
ready access to commonly used features. From items on the Toolbar,
users can perform simulation file operations, change the simulation time
and view perspective settings, and change the Drawer contents.
Generally, items on the Toolbar are duplicated by corresponding items
in the main menu.

Application

Unlike many applications, Freefall has only a single main window. It
was designed this way because the computations are so intense that only
the fastest machines are capable of adequately managing multiple
simulations simultaneously. Because of this design, closing the window
is equivalent to quitting the application.
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Changing perspective with the mouse

The center of the window, the focal point, is either the center of the
Earth, a location on the surface of the Earth (generally a city selected in
the Cities window), or a specified satellite. In Freefall, these three
perspectives are called "Earth-Centered Inertial," "Earth-Surface Fixed,"
and "Satellite" respectively and can be changed using items under the
"View" menu and from the Toolbar. In some circumstances, Freefall
changes the perspective automatically when appropriate. for example,
when the user selects a city in the Cities window. In order to center the
city in the view, Freefall changes the perspective to "Earth-Surface
Fixed."

Keep this when changing the perspective with the mouse. The behavior
may appear to change depending on the current perspective setting, but
it is the same, just the focal point of the view has changed.

If the mouse is over a satellite (even one obscured by the Earth), when
the mouse is clicked, then the satellite will be selected instead of
entering rotate, zoom, or pan mode.

Rotating the view

To rotate the current view, click and drag the mouse in the main display
window. Use the left mouse button on mice with multiple buttons.
Generally, move the mouse in the same direction as the desired scene
rotation: moving the mouse up rotates up, moving the mouse left rotates
the scene left.



This method of rotation is fairly common, but if this does not seem
intuitive, practice first with simple motions (left only, right only, down
only, up only).

If you hold the option key down when clicking the mouse, the rotation
will be restricted to a single axis -- either up/down only or left/right
only.

Zooming in and out

To zoom in or out, press the shift key while clicking and dragging the
mouse. Or, if the mouse has a middle button, simply click the middle

mouse button and drag. Moving the mouse up zooms out. Moving the
mouse down zooms in.

Alternatively, if the mouse has a scroll wheel, moving the scroll wheel
down should zoom in and moving it up should zoom out.

Panning

To pan the scene, press the control (ctrl) key while clicking and
dragging the mouse or by clicking the right mouse button on a mouse
with multiple buttons and dragging. The view will move with the
mouse.

Re-centering the view
If the current view perspective gets out of control, use the "Re-center
View" menu item under the "View" menu to make it reasonable.

Selecting satellites

To select a satellite, click on it with the mouse; use the left button on a
mouse with multiple buttons. To select multiple satellites, hold the shift
key while clicking. To select a group of satelites, double-click, and
triple-click to select all satellites. If the mouse is over a satellite that is
obscured by the Earth, it will still be selected.
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The main menu and toolbar

For the most part, the Main Menu duplicates the functionality of the
Toolbar. The menu items that correspond to a particular Toolbar
function will be noted along with the Toolbar function's description.
Because the Toolbar is customizable by the user, the default Toolbar,
shown below, may differ somewhat from the Toolbar in the Freefall
window. The Toolbar can be shown or hidden and customized by menu
items under the "View" menu.

A

Simulation

This pop-up menu button is a shortcut for the "File" menu. When
closed, it displays the name of the current simulation. Open, it is
separated into two parts. The top part displays a list of the other
simulations contained in the same folder as the current simulation.
Selecting one of these menu items will open the associated simulation.
The items in the lower part perform a file operation on the currently
open simulation:

New Creates a new simulation

Creates a new simulation by duplicating

Duplicate . .
P the currently open simulation



Save Saves the current simulation

Saves the current simulation to a user-
Save As... .
specified file

Reloads the current simulation from the

Revert .
v version stored on the file

All of these operations are available under the "File" menu.

Appearance, Views, Satellites, Cities, and Info

These buttons determine which window is visible in the Drawer. If the
Drawer is not open, pressing one of these buttons will open it. If the
Drawer is already open to a particular window and the same button is
clicked in the Toolbar, the Drawer will close. If the Drawer is already
open and a different button is clicked, the contents of the Drawer will
change to the new window.

The corresponding menu items are under the "Simulation" menu.

Speed, Time, and Increment

These controls affect simulation time. Speed controls how fast the
simulation runs relative to real-time (eg. a setting of 100x indicates that
the simulation is running or will run 100 times faster than real-time).

The buttons in the "Time" item control the simulation time directly.
These buttons will be described from left to right.

The first button controls whether or not the simulation is running. If the
simulation is running, pressing this button will stop the simulation; if it
is not running, pressing this button will start the simulation.

The second button determines whether or not transitions between views
will occur during the simulation. Each simulation contains a list of
views which define different perspectives of the simulation. When this
second button is turned on, the views will transition in sequence in the
same manner that they would in the Freefall screen saver. When it is
turned off, the view perspective in the main window will not change.
This button is normally used only for testing the view sequence once it
has been defined; many of the simulation editing controls will
automatically turn this button off to avoid undesirable transitions during
the definition phase.

The third button will set the simulation time to the current clock time on
the computer, and will stop the simulation if it is running.

The fourth button enables users to manually take a single simulation
step. A single click of this button will add a specific amount to the
current simulation time. This amount is defined by the "Increment"
control. For example, if the simulation time is currently 18:12:03, the
"Increment" is set at "5 sec," and this button is clicked, the new
simulation time will be set to 18:12:08 and the positions of all
simulation elements will be recalculated for this time and the main
window redisplayed.

The corresponding menu items are in the "Simulation" menu.

Perspective
The control will change the perspective of the current view in the main



window. From left to right, the buttons select "Earth-Surface Fixed,"
"Earth-Centered Inertial," and "Satellite."

In "Earth-Surface Fixed" mode, the view is focused on a point on the
surface of the Earth; which is typically the last city selected in the Cities
window. In "Earth-Centered Inertial" mode, the view is focused on the
center of the Earth and the observation point (or camera) remains fixed
in space. In this mode, the Earth rotates when the simulation is running.
In "Satellite" perspective, the focal point of the view is an individual
satellite. This satellite is specified by selecting a satellite from the list in
the Satellites window. It can also be specified or by selecting a satellite
in the main window using the mouse and then pressing the satellite
button in the Perspective item in the Toolbar.

The perspective menu items are in the "Perspective" menu under the
"View" menu.

Help
This item is simply a shortcut for the on-line help.

Menu items not available on the toolbar
A few menu items do not have corresponding toolbar controls:

Re-center

This menu item sets the current view parameters in the main window to
reasonable settings. Although it does not have a separate item in the
toolbar, clicking on the perspective control for the current perspective
will perform the same operation and also re-center the view.

Full-screen

Selecting this item, which is under the "Window" menu, allows users to
see how the simulation will look when run from the screen saver. Only a
few of the normal commands work from their keyboard equivalents
when the application is full-screen mode. The two important ones are
Start and Stop simulation and transition view. To exit full-screen mode,
press "shift-command-F" or a key on the keyboard besides the spacebar.
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Working with simulations

Simulations are stored as files, but they are treated somewhat specially
Freefall as described in this section.

Individual simulations belong to a group. The group is defined by a
folder that contains simulation files. The default simulation group is
stored in the "Library" folder of the user account and is called "Freefall
Simulations." Other folders that contain Freefall simulation files can be
created and used. The significance of this grouping is that simulations in
the same group can quickly be accessed from pop-up menus in the
Toolbar and Preferences window. Also, the screen saver can be
configured to cycle through all the simulations in a given group.

The second special behavior is that the simulation files must have a
" ffs" filename extension. This is managed automatically by Freefall so

users generally do not need to worry about this.
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Changing the appearance



L

To change a simulation's appearance, open the Appearance window in
the Drawer by clicking the Appearance button in the Toolbar or at the
top of the Drawer, or select the "Appearance" menu item under the
"Simulation" menu. The Appearance window is shown on the right.

The appearance controls are self-explanatory for the most part; the
exceptions are discussed below. The most enjoyable way to learn what
they do is to discover it by experimentation.

When the user changes a setting, the effect on the main window is
instantaneous, and the changes will be stored with the simulation when
the simulation is saved.

Please note that these settings can have a significant effect on animation
performance and can mean the difference between a smooth animation
and a poor one. See the section on Performance tips for details.

Show ground links

Freefall can determine whether or not a satellite is in contact with a
defined ground station using a simple line-of-sight approximation: if the
satellite and ground station are visible to each other, they are in contact,
otherwise they are not. When "Show ground links" is turned on, these
links are indicated by lines drawn from the satellite to the ground
station, when it is turned off, no ground links will be calculated or
displayed. The ground stations are defined by the user in the Cities
window, and which satellites display ground links are defined in the
Satellites window.

Show custom network

Users can define a custom satellite network. The network indicates radio
contact between its members, and is also calculated using the same
simple line-of-sight approximation as the ground links. When "Show
custom network" is turned on, the current network radio connections are
represented with lines between connected satellites. Although these
custom satellite networks themselves are purely imaginary constructs of
the user, it is fascinating to see how dynamic actual satellite networks
can be.
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Modifying views

To modify a simulation's |}

views, open the Views window in the Drawer by clicking the Views
button in the Toolbar or at the top of the Drawer, or select "Views"
menu item under the "Simulation" menu. The Views window is shown
on the right.

Each simulation contains a list of views. A view defines the perspective
of the main window. Although they can be used simply as a list to store
favorite perspective settings, they are generally used to define a
sequence of views through which the application or screen saver will
cycle.

Creating and removing views

To create a new view, click the "+" button at the bottom of the list. New
views are created using the perspective defined in the main window. To
delete a view, click the "-" button. A simulation must have at least one



view, so the "-" button is disabled when there is only one view
remaining.

Changing view properties

Each view has a user-definable name. To change the name, double-click
in the "View" column of the appropriate view. The checkbox in the the
"Use" column indicates whether or not the view will be used in during
the transition sequence. To remove a view from the sequence but
preserve it, set the checkbox to un-checked.

To set or change the perspective a view, select the view to change in the
list, set the main window perspective to the desired view perspective,
and press the "Apply current perspective" button.

Setting the main window perspective

To set the perspective of the main window to a particular view, select
that view from the list. If the simulation is not running, the main
window perspective will be updated immediately, but if it is running, the
main window will transition to the selected view.

Transition controls

These two controls determine how the view sequence will transition.
The "Delay" control indicates the delay between transition events, and
defines how long each view will be displayed before transitioning to the
next view in the sequence. The "Duration" setting specifies how long
the transition between views will be. It is defined by number of frames
rather than time because animation speeds are so variable. It is
important to select a duration so that the transition finishes before the
next transition is initiated. For example, if the current animation speed is
20 frames per second, and the duration is set to 60 frames, the transition
will take 3 seconds. The delay should be specified as something greater
than 3 seconds.
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Working with satellites

When working with a i

simulation's satellites, open the Satellites window in the Drawer by
clicking the Satellites button in the Toolbar or at the top of the Drawer,
or select "Satellites" menu item under the "Simulation" menu. The
Satellites window is shown on the right. It has two sections.

Satellite selection

The upper section contains a list of available satellites, a find feature,
and a control that allows the user to quickly select all satellites in a
group. To locate a satellite in the main window and select it, select on
it's name in the list. The show checkbox next to the name determines
whether or not the satellite is displayed.

To find a satellite, enter text for which to search in the field next to the
"Find" button and then press "Find." Pressing "Find" multiple times will
subsequently find the next satellite.

To select all the satellites in a group, select the group from pop-up menu
button titled "Select satellite group."

Satellite properties
The lower portion of the Satellites window contains controls to change
the properties of the selected satellites. Because multiple satellites with



different settings can be selected, most of the controls have 3 settings --
"on", "off", and "mixed." When the particular setting of all the selected
satellites is the same, the control is either "on" or "off." If the setting is
not the same for all selected satellites, it is "mixed." On checkboxes,
"mixed" is indicated by a "-." When settings are all the same, the
checkboxes work as simple on/off toggle switches. In "mixed" mode,
the checkbox cycles through all three modes. In this case, when the
checkbox is turned on, the setting for all satellites will be turned on;
likewise for off. To keep the original state of each satellite (eg, no

change to that setting), put the checkbox back in "mixed" state.
The setting take effect immediately and the main window is updated.

Caution! The notable exceptions to this mixed-selection behavior are
the color settings. Once the color is changed, the colors for all satellites
are set. There is currently no way to undo this.

Line-of-sight footprint

The "Line-of-sight footprint" is the area on the Earth's surface that is
visible to the satellite at any instant in time (and equivalently, encircles
the region on the Earth from which the satellite is visible). This area
increases with the satellite's altitude up to the maximum region, a full
hemisphere.

Tail

The tail shows the previous position of a satellite. It helps users
visualize the path of a satellite's orbit, and its length gives a qualitative
indication of the satellite's speed -- the faster a satellite moves, the
longer its tail.

Custom network member

The custom satellite network is described in general in the section on
Appearance. This checkbox is used to define which satellites are
members of the network.

To define a new network, first select all satellites, and turn this
checkbox off. Then select the satellites you want in the network, and
turn this checkbox on.

To add or remove a satellite (or satellites) from the network select it (or
them) and mark this setting accordingly.

Axes

The axes are fairly small and clearly identifiable only when the view
perspective is close to a satellite. They represent a standard satellite
coordinate system -- a vector pointing in the direction of the satellite's
motion, a vector pointing directly towards the Earth's center, and a third
vector orthogonal to both.

Ground station radio links

Ground links are described in general in the section on Appearance. To
calculate and display the ground links for the selected satellites, mark
this checkbox; otherwise unmark it.

Sensors

Most satellites have a number of on-board sensors or antennas; at a
minimum, this includes at least one radio to transmit or receive
information. Many of these radios or other sensors are directed towards
the Earth. In the ideal case of an omnidirectional antenna and line-of-
sight approximation, the area on the ground covered by the sensor is
equivalent to the line-of-sight footprint. Directional sensors have much



different, typically ellipsoidal, coverage patterns.

The sensors are not the real spacecraft sensors, they are hypothetical
models; fake. The area coverage displayed would be the real area
coverage of the sensors if the satellite carried them.

In short, though the satellites and coverage calculations are real, the
displayed patterns are meaningless. Sensors were included as a satellite
feature with Freefall for the sole reason that the patterns are interesting,
and the hypothetical sensors (which, though themselves fake are based
on real, albeit simple, models) illustrate clearly and in a highly visual
manner the ellipsoidal shapes that typical sensor systems exhibit.
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Using the cities database

To use the cities database to |, |

specify cities in a simulation, open the Cities window in the Drawer by
clicking the Cities button in the Toolbar or at the top of the Drawer, or
select "Cities" menu item under the "Simulation" menu. The Cities
window is shown on the right.

Freefall contains a database of over 28,000 cities and other geographic
locations. Users can choose which cities to display in the simulation,
they can specify which locations have ground stations for the ground-
station/satellite radio links, and they can add up to 256 custom locations.

To display a city on the Earth, find the city in the list and check the
button in the "Show" column on. To specify the location as a ground-
station, check the button in the "Link" column.

Locating a city in the main window

To locate a city in the main window, select it in the list of cities. When a
city is selected, the main window perspective will change to "Earth-
Surface Fixed" with the specified city at the focus.

To find a city in the list and select it, type the text for which to search in
the field next to the "Find" button and press "Find." The search is case-
insensitive and looks for any portion of the city name. Subsequent clicks
on the "Find" button will find the next matching city. If a city is found,
it is selected in the list and centered in the main window in the same
manner that selecting it manually would.

Adding and removing user-defined cities

To add a city, press the "+" button at the bottom of the cities list. This
will add a new location to the end of the list. To set the name, latitude,
and longitude of the new location (or another existing user-defined
location), double-click on the line in the column being modified. The
names and geographic coordinates of only the user-defined cities can be
modified.

For simplicity, the changes will be saved to the user city database the
next time the simulation is saved. To discard city modifications, do not
save the simulation; to save them, make sure to save the simulation
before exiting the program.

To allow multiple simulations to share common user-defined cities, the
user-defined cities are stored in a system-wide location; they are not part
of the simulation. The "Show" and "Link" settings, however, are stored



independently for each simulation.

nn

To remove a user-defined city, click the
cities can be removed.

button. Only user-defined

Ground stations
The locations for a number of real ground stations are included in the
cities database. They begin with "Groundstation -".
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Finding more information about a satellite

To find out more =

information about a satellite, open the Info window in the Drawer by
clicking the Info button in the Toolbar or at the top of the Drawer, or
select "Info" menu item under the "Simulation" menu. The Info window
is shown on the right.

This window displays the position and speed of the satellite, in either
metric or English units, at the current instant in simulation time. It also
contains supplementary information about most of the satellites
included with Freefall.

Please note that the supplementary satellite information may not be
viewable. This feature requires OS X 10.2.7 or later or OS X 10.2 with
Safari 1.0 or later.

The window will display information for the selected satellite only
when a single satellite is selected. The information is updated when the
simulation is running, but will slow the animation speed somewhat.
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Using Freefall as a screen saver

Freefall includes a screen saver that can be used in the normal Mac OS
X fashion, and is accessible from the System Preferences.

To use the Freefall screen saver, open the System Preferences and select
either "Desktop & Screen Saver" or "Screen Effects." Choose Freefall
from the list, and configure it using the "Options" button. Please see the
Preferences section for a description of the screen saver configuration
options.
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Freefall preferences

Because the screen saver is essentially the Freefall application without
an interactive user interface, they share the same preference settings
with two notable exceptions described later in this section. In the
Freefall application, the Preferences window is accessed from the
"Preferences..." item under the Freefall menu. It can also be displayed
by clicking the "Options" button in the OS X screen saver System
Preferences window.

The Preferences window is illustrated below:



Serial Number

Freefall requires a valid serial number to function normally. Enter the
serial number here. Once the serial number has been successfully
entered, the The "Buy Now" button will disappear and the text entry
fields become disabled.

Default Simulation

To choose the default simulation Freefall will open when it first starts,
select an item from the pull-down menu or click the "Choose..." button.
Clicking the "Choose..." button will open a standard file selection dialog
and allow the user to select a simulation file. Simulation files must have
a ".ffs" extension, that may or may not be visible.

Because simulations are generally grouped together in folders, the pull-
down menu provides a short-cut for choosing another simulation in the
same folder.

Please note: The "Default Simulation” section is the only difference
between the application preferences. First, the default simulations for
the application and screen saver are independent. Selecting the default
simulation in the application preferences will not change the screen
saver default simulation. Second, the screen saver has an extra check
box and slider control that allow users to choose whether or not to cycle
through simulations in the specified folder and for how long each
simulation should be displayed. When this option is enabled, the screen
saver will sequence through the other simulations in the same folder that
contains the default simulation. Each simulation will run for the amount
of time specified by the slider control.

Use best rendering quality

Freefall looks best when this option is enabled, but it requires extra
processing for each frame, and unfortunately not all video cards support
this feature well. We recommend enabling this feature unless
performance considerations or video card problems dictate otherwise.

Orbit propagation model

This parameter controls the orbit propagation algorithms used to predict
satellite positions. The SGP4 algorithm is generally better suited for
Low Earth Orbit (LEO) satellites; the SDP4 algorithm is designed for
deep-space orbiters. The SDP4 algorithm, which takes into account the
gravitational forces of the Sun and the Moon on the satellite, is
computationally slower and so complex that it is often miscalculated --
even the standard reference implementation contains known flaws.

Check for new versions of Freefall software
If this option is checked you will be informed automatically when a new
version of Freefall becomes available.

Satellite Update



Update satellite data automatically from Space-Track

Satellite position tracking is a fascinating and highly complex subject.
In a sentence, it entails taking the satellite's known position ("elements")
at a specific time ("epoch") and using mathematical models ("orbit
propagators") to predict its position at a future time. Though this
description is a gross oversimplification, the orbit propagators used by
Freefall can accurately predict satellite positions for a number of days
past epoch.

To keep the satellite positional data current, Freefall can download the
latest satellite elements automatically over the Internet from the Space-
Track system. This automatic download process will occur at most once
per day, which is often enough to ensure constantly accurate satellite
positions.

Although the files are not large, we recommend that this feature NOT be
enabled unless the computer has a persistent, high-speed connection to
the Internet. Even with such a connection there will be a delay during
Freefall application start up (approximately once per day) when it
determines that an update is required.

Username and Password
Access to current satellite information requires a Space-Track account.
Enter your Space-Track Username and Password here.

More information about Space-Track

Remember Password
For convenience, Freefall will remember your Space-Track Password if
this option is enabled.

Advanced Settings

These settings primarily affect the Freefall rendering engine, and can be
used to help optimize rendering performance and quality on specific
machines.

Image resolution

Although video cards with even 16MB of VRAM have enough to store
the image data and other textures Freefall uses, Freefall needs to share
the video memory with other applications and the operating system.
This can cause problems even on machines with as much as 32MB of
VRAM, often indicated by the earth imagery disappearing. To reduce
the amount of VRAM used by Freefall (and avoid these problems),
select a lower image resolution.

Optimize label rendering



Freefall has two methods for rendering labels on satellites. The
"optimized" setting is much, much faster, but uses significantly more
VRAM and may fail on systems with limited video memory.

Vector Renderer

Freefall also has two independent methods for rendering the vector GIS
information (coastlines and political boundaries). Depending on the
machine, "Vector Renderer B," may provide slightly better performance,
but "Vector Renderer A" uses a more robust rendering path.

Disable point antialiasing

Certain video cards have trouble rendering antialiased points, which
causes the satellites to intermittently disappear. Since there is currently
neither a solution nor a workaround for this problem, users can enable
this option to avoid it by turning off the antialiasing for points without
disabling line antialiasing.

Synchronize VBL

In full-screen mode when this option is enabled, Freefall will
synchronize its screen refresh with the display refresh to avoid problems
with "tearing." On older machines though, enabling this this can feature
can cause even worse visual artifacts. Users with newer machines may
want to enable this feature for best animation quality.
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Space-Track

Recent federal regulations restrict distribution of current satellite data
(commonly known as 'TLEs'). Space-Track has replaced NASA's
Orbital Information Group as the primary source for this information,
and it provides access only to users with a registered user account. Since
Advanced Analytic can no longer redistribute satellite TLE data,
Freefall users will need an account on Space-Track to keep Freefall's
satellite data current.

Fortunately, applying for a Space-Track account is an easy process. Start
at this web page http://www.space-track.org and be be prepared to enter
the following required information:

¢ Username (for the requested new account),

e Name (first and last),

e Address (street, city, state, zip, and country),

e Email address,

e Organization, and

¢ Interests (Educational, Amateur Observer, Ham Radio Operator,
Hobbyist, Government, Military, Satellite Owner/Operator)

The application process takes only a few minutes, and new accounts are
created within a few days.
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Importing and upating TLEs

Selecting the "TLE Import..." item under the "File" menu will open the
TLE Import window, shown below:

The main section contains a list of satellite groups and their satellites.
Each satellite line also displays the epoch date for the corresonding
TLE.

Adding new satellite groups

The simplest way to add a new satellite group to Freefall is to drag-and-
drop TLE-format files from the Finder onto the list of satellites. These
files can also be selected by clicking the "+" button which will open a
standard file selection dialog box.

Please note:This version of Freefall supports up to 1024 total satellites.
Since almost 860 are pre-defined, only about 165 new satellites can be
imported.

Removing satellite groups
To remove satellite groups, select them in the list and click the
button. This operation cannot be undone.

nn

Updating TLE data from Space-Track

Freefall's 860 pre-defined satellites can be updated manually from
Space-Track by clicking the "Update Now" button. This feature requires
a registered account on the Space-Track system. Clicking "Update
Now" will not update imported satellites. The button is disabled when
the satellite data is current.
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Performance tips

Although Freefall's core graphics and math engines are highly
optimized for outstanding performance, the massive computations
involved for calculating the positions of over 850 satellites using
sophisticated orbit propagation algorithms, their line-of-sight footprints,
and sensor ground coverages at animation frame rates are staggering.
Freefall can stress even the fastest machines, but is designed to operate
adequately on a wide variety of systems.

A number of factors affect performance, which is measured subjectively
by how smooth one perceives the animation to be and objectively by the
"Animation speed" displayed in the status bar along the bottom edge of
the main window. Roughly, an animation speed over 20 frames per
second (fps) is desirable. Speeds below 10 frames per second are too
slow, unless the simulation speed is set at 10x real-time or slower. In
this case, Freefall adjusts its animation rate automatically to reduce the
load on system resources.

For example, if the simulation speed is specified as 5x real-time,
Freefall will choose a maximum animation speed of 5 fps, since
rendering any faster than that would be a waste of system resources. If
the simulation speed is set to Real-time, the Freefall window will only
update once per second. Therefore, if the simulation speed is set below
20x real-time, the animation speed is not a valid indicator of software



performance.

Other factors that affect performance include:

e System hardware configuration

e Other running applications or processes utilizing system
resources

¢ Intermittent system events

¢ Freefall simulation settings

If the system meets the recommended system requirements, an
animation speed of 20 fps or better should be attainable when no other
applications or processes are consuming system resources, no
intermittent system events occur, and the Freefall simulation settings are
configured appropriately. If the system meets the minimum system
requirements, 20 fps may not be attainable, but 10 fps should be.

The following tips may help improve Freefall's performance:

Other Applications and Processes
Freefall is intense. For best performance, shut down any other
applications that may be using system CPU and graphics resources.

Intermittent System Events

Occasionally, high-priority events will spike the CPU load and
drastically affect Freefall's performance. This can drive an animation
speed from 24 fps to below 5 fps. There is no way to avoid this; merely
users should be aware that it sometimes happens. Freefall adapts to the
current system environment and will recover from these performance
hits, although somewhat slowly.

Freefall constantly monitors the animation frame rate in order to ensure
the simulation is running at the specified simulation speed and it tries to
provide the smoothest animations possible. The simulation is re-
calibrated during every view transition; during this re-calibration,
Freefall's animation timer requests 2 fps more than the current
animation rate. When the system has reached maximum performance,
this extra rate will have no effect, and the animation speed will stabilize.
When the current animation speed is below the maximum performance,
it will get closer to it by 2 fps during every calibraration (though during
this time the actual simulation speed is slightly faster than the specified
speed). If Freefall is running an animation smoothly at 24 fps and a
single system event occurs that momentarily drops the rate to 8 fps , but
then goes away, Freefall will be running again at 24 fps 8 transitions
after the occurrence.

Freefall Simulation Settings

Here are a number of suggestions that may improve performance.
Generally, each contributes a certain amount, although certain
combinations will work better than others depending on what feature
becomes the performance bottleneck on a specific system.

Performance tuning is as much a matter of personal taste as it is a matter
of system hardware. Particular features that are important to one person
may not be important to another. Experimentation with the simulation
settings is the best method for determining the optimal balance of
performance and features. Choosing these settings appropriately is
critical for tuning performance; on a 1.25GH G4 PowerBook the
following suggestions can bring a 10 fps animation to well over 60 fps,



which is easily the difference between a poor animation and an
incredible one. The first six generally have the biggest impact.

1. Turn off the display of coastline and political boundaries in
the Appearance drawer.

2. Reduce the number of satellites displayed in the simulation

3. If the video card has 64MB of VRAM or more (in many
cases 32MB VRAM is enough also), enable optimized label
rendering in the Advanced section of the Preferences. On
systems with less VRAM, minimize the number of satellites
that show labels.

4. Turn off "Use best rendering quality" in the Preferences.

5. Do not display satellite sensors, line-of-sight footprint,
ground-links, or satellite network, or reduce the number of
satellites that display these features.

6. Turn off the time display in the Appearance drawer.

7. Turn off the display of the latitude/longitude grid or choose a
grid resolution of 10, 15, or 30 degrees.

8. Do not display the Info drawer while a satellite is selected and
the simulation is running.

9. During the simulation make sure at most one satellite is selected.

10. Reduce the size of the main window.
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Troubleshooting

This section describes a number of common problems and their
solutions.

Problem: The earth imagery disappears or never appears.

Solution: The video card does not have enough memory to reliably store
the image. Open the Preferences window and go to the Advanced
section. Reduce the image resolution.

Problem: The lines flicker.

Solution: Generally this occurs when the animation speed is between 11
and 15 fps and only on certain video cards. Experiment with the
performance tips to improve the animation speed; in particular turn off
the display of coastlines and political boundaries, turn off the
latitude/longitude grid, and and reduce the number of satellites
displayed in the simulation. When the animation speed is above 20 fps
this flickering should stop.

Problem: The satellite points turn gray or disappear altogether.
Solution: Unfortunately, not all video cards properly support antialiased
rendering. First, in the Advanced section of the Preferences, disable
point antialiasing. If this does not solve the problem, deselect "Use best
rendering quality" in the Preferences window.

Problem: The cities appear to "wobble" or "jitter".

Solution: Unfortunately, not all video cards properly support antialiased
rendering. Deselect "Use best rendering quality" in the Preferences
window.

Problem: Full-screen mode appears broken.

Solution: To improve the animation quality on newer machines that are
capable of animation speeds on the order of the display refresh rate, in
full-screen mode Freefall synchronizes its drawing with the vertical



blank. Unfortunately, this fails on certain older machines. Go to the
Advanced section of the Preferences and make sure that "Synchronize
VBL" is not checked.

Problem: Full-screen mode exhibits "tearing."

Solution: Freefall can synchronize drawing with the vertical blank,
which should eliminate the "tearing" problem. Go to the Advanced
section of the Preferences and check "Synchronize VBL".

Problem: When the main Freefall window is zoomed, the drawers do
not appear to open.

Solution: Reduce the size of the window; the drawer should be visible.
If not, open the drawer, and then zoom the window.

Problem: Changes to the appearance while the simulation is running
seems to change the simulation speed.

Solution: Trigger a simulator calibration by manually transitioning the
view or by stopping and restarting the simulation. The simulator re-
calibrates itself on every view transition, so if the simulation is running
while views are transitioning this will happen automatically.
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Limitations of the free version

The evaluation version of Freefall, which can be downloaded freely, has
many features disabled. The limitations of the evaluation version are
described in this section.

Simulation

Only the default set of simulations that shipped with the Freefall
evaluation version can be opened. New simulations cannot be created,
simulations cannot be saved, and the revert simulation feature is
unavailable.

Appearance
The only controls available in the limited version are those that select
which Earth imagery to display and the night shading control.

Views
Views cannot be created, removed, renamed, reordered, or modified in
any way. The transition controls are disabled.

Satellites
None of the satellite settings can be modified.

Cities
Cities cannot be created or removed; their display and ground station
settings cannot be modified.

Info

The supplementary satellite information window (if available) only
displays the information for NOAA 17 as an example. It does not show
the information for the currently selected satellite.

Simulation Speed
The simulation speed can only be changed to 10x, 50x, and 200x real-

time.

Simulation Step Increment



The simulation step increment can only be changed to 5 seconds.

TLE Import
Satellite TLE data cannot be imported or updated

Splash Screen
The limited version always displays a splash screen during application
startup. The unlimited version does not.

Test Flight Watermark

The main window is partially obscured by the "Freefall Test Flight" text
to remind users that this software should be used for evaluation
purposes only. The unrestricted version is not.

Window Placement
The windows are not restored to their previous sizes and locations; in
the unlimited version they are.

Freefall Manual Contents

Uninstalling Freefall

Unfortunately, Apple's Installer does support an uninstall feature, so
Freefall must be uninstalled manually. Here are the items Freefall
installs; to uninstall Freefall remove them manually from the hard drive
using the Finder:

In the root folder:

e Applications/Freefall
e Library/Frameworks/Freefall.framework
e Library/Screen Savers/Freefall.saver

In the user account:

e Library/Preferences/com.advancedanalytic.freefall.plist
e Library/Freefall
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Credits

"The Blue Marble" Earth imagery
© NASA
http://visibleearth.nasa.gov
http://earthobservatory.nasa.gov
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